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Week Assignment

Software Testing — Test Execution

Hans-Petter Halvorsen



Week Assignment

1. Start to Test your Software according to STP
2. Create Unit Tests for your Code

3. Scrum Activities and Meetings

— Finishing Beta Iteration

 Sprint Review Meeting)
* Sprint Retrospective Meeting

— Start Working on Next Iteration (RC)
e Sprint Planning Meeting




In software engineering, a freeze is a point in time in the development process after which the
rules for making changes to the source code or related resources become more strict, or the

period during which those rules are applied. https://en.wikipedia.org/wiki/Freeze (software engineering)
Code Freeze: Tuesday 10:15-14:00 and Friday 10:15-14:00

qum

[ No Programming in Class these 2 weeks! — otherwise it is easy to loose focus on Testing ]



https://en.wikipedia.org/wiki/Freeze_(software_engineering)

Why Testing?
Make sure the software fulfills the Requirements from the
Customers (Software Requirements Specification, SRS)
Make sure the Software don't contain critical Bugs

Make sure the software can be installed at the customer.
The customer don't have Visual Studio!

Make sure the software are user-friendly and intuitive to
use

Make sure the software is robust and has acceptable
performance (so it don't crash when more than 1 person are
using it, or if the database contain lots of data, etc.)



Test Planning and Execution

4 )\
1 Create Software Test Plan (STP)

G %

4 )\
2 Create Virtual Test Environment

g J

0

—— Test Planning

Previous Week

3 [ Test the Software according to STP

Create Unit Tests in Visual Studio

—— Test Execution

This Week
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Levels of Testing

___—» Unit Testing: Test each parts
(1» independently and isolated

—

______

/ @
— Regression Testing: Test
Integration Testing: Make sure ¥ that it still works after a

that different pieces work change in the code
together. Test the Interfaces
between the different pieces.
Interaction with other systems
(Hardware, OS, etc.)

System Testing: Test the whole system



Testing

* Test you software according to the Requirements and Design
Documents and the Software Test Plan

* Report Bugs as Work Items in Azure DevOg

Software Test
Plan (STP)

-
-
-

i : Document )
[ PITannlr';\g Tests ]—>[ Perfor_m Tests J——{ Test Results J

Software Design Document (SDD) : - Functional & Non-Functional Requirements
Software Requirements Specifications (SRS) 1 - User & System Requirements

Software Test
gt Documentation (STD)




Why Find Bugs early?

Cost per defect/Bug

Software Development Life Cycle (SDLC) >




Testing

Requirements Development & Coding

Code Final

&3esign . . . Freezb Q@'very

© s m
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Continuous Testing in the whole SDLC! Q.
Testin Testin
Increased Increased Increased Increased
Focus Focus Focus Focus
Requirements Requirements & Functionality So.ft_ware without
Functionality Critical Bugs

Agile/Scrum: Periodically Iterations/Sprint every 14-30 days

You can never find all Bugs!

Released Software do have Bugs!



Eat dog food T;&B
at your own dog food |- =

* You are not giving food to your dog without first
taste it yourself?

* You are not giving things to others that you dont
like yourself?

* This means that you should use the Software you
create yourself on a daily basis.

* If you are happy with the Software and are able to
use it, most likely the Customer will also like it and

be able to use it
Eating your own dog food - Wikipedia



https://en.wikipedia.org/wiki/Eating_your_own_dog_food
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Test your Software

Test your system according to the Software Test Plan
(STP).

— Make sure to test the part of the Software that you have
not created

Make sure to document the Test Results.

— Bugs should be in addition be reported as “Bug” Work Items
in Azure DevOps.

Create Queries in Azure DevOps (a “Buglist”).
— Prioritize and Fix the Bugs according to the List of Bugs
Make Software Test Documentation (STD)

See Next Slides for more details...



Test Execution and Reporting  ame:

[ One of the students submitting this form will receive a prize! ]

Start Testing the entire Software (and Documentation)

O My Test Environment is ready

(d Read the STP and start testing according to STP

(d Execute and Fill in Test Cases.

O Try to break the system. Do the unexpected!, go crazy!
d Each Person should Report at least 10 Bugs

or Features in Azure DevOps (Work Items)

(d Each Person should create at least 2 personal (My Queries) Queries and 2

Shared Queries in Azure DevOps. Examples:
Bugs Assigned to Me

Zugs :epo[ted ;’Z EI/Ie Team Query 2:
ew Bugs Last 24 Hours, etc. Team Query 2:

d Upload Test Cases you have filled out to Teams or Azure DevOps
O Prioritize and (later) Fix the Bugs according to the List of Bugs

# Bugs:
# New Features:

My Query 1:
My Query 2:




Development vs. Testing
M You need to think

"HOW CA&;”I "HOW CAN ?ZE different when Testing
MAKE [T : BREAK IT : compared to when

Developing the System

www,zelger.org

Goal: Find as much
bugs, improvements,
etc. as possible!!!

They weren't so much different, but they had different goals

http://testingeduindia.blogspot.no/2014/04/a-day-between-developer-and-tester.html



http://testingeduindia.blogspot.no/2014/04/a-day-between-developer-and-tester.html

How shall tests be documented?

It is not enough simply to run tests

The results of the tests must be systematically
recorded.

Typically, the Customers wants to see documentation that the system has been
properly tested

Or the Quality Manager will not approve that you release a Software without seeing
the documentation that the system has been properly tested

It must be possible to audit the testing process to
check that it has been carried out correctly

How you do this must be described in the Software
TeSt Plan (STP) http://www.softwareengineering-9.com/Web/Testing/Planning.html|



http://www.softwareengineering-9.com/Web/Testing/Planning.html

Software Test Documentation (STD)

Suggestions of contents:

 Executed Test Cases that the Testers have filled
out (Passed/Not Passed, Comments, etc.)

* Export of reported Bugs from Azure DevOps

* Some Plots/Charts that gives an overview of
number of Bugs Reported and Fixed, etc.

* |n addition, some text explaining these things



STD Contents Examples

 Code Reviews
* Test Environment
 Executed Test Cases
* Test Results
* Bug Reports, Bug Queries
* Analysis of Testing and Test Results (Tables, Charts, etc.)
— Number of Bugs found, Number of fixed bugs, remaining bugs, etc.
* Discussions and Conclusions
— |Is the system ready for release?
Details can be in Appendices or available as separate documents
— STD document and details should be available from HTML Web Site



When to Stop Development?

Software Finished

“100%’
1190%”

:}' Details, small adjustments, etc.
The last 10% takes a lot of time!!!

Sooner or later you have to say enough is
enough and release version 1.0.

One must define within the development
company, development team or in dialogue
with the customer what is defined as "good
enough". Software will never be 100% complete
or error-free!

Time



When to Stop Testing?

http://dilbert.com

OUR GOAL I5 TO WRITE
BOGFREE SOFTWARE.
T'LL PAY A TEN-DOLLAR
BONUS FOR EVERY DBUG
YOU FIND AND FIX.

S Ams E-mall: SCOTTADAMSEAOL.COM

N

/i/"} © 1995 United Feature Syndicate, Inc.(NYC)

T HOPE
THLS
DRIVES
THE RIGHT

BEHAVIOR.

T GONNA
WRITE ME A
NEW MINIVAN
THIS AFTER-
NOON!

A simple answer is to stop testing when all the planned test cases are
executed and all the problems found are fixed. In reality, it may not be
that simple. We are often pressured by schedule to release software

product.


http://dilbert.com/

When should you stop Testing?
(depends on Time, Budget, etc.)

In the beginning it it easy to
find bugs with few resources

Critical Point Time



When to Stop Testing?

e When the tester has not been able to find another
defect in 5 (107 307 100?) minutes of testing

* All code reviews and walkthroughs have certified the
code as ok

 When a given checklist of test types has been
completed

 The code has passed all unit tests
 When testing runs out of its scheduled time

These things needs to be documented in the Software Test Plan (STP)

E. J. Braude and M. E.Bernstein, Software Engineering: Modern Approaches, 2 ed.: Wiley, 2011. +++



80 — 20 Rule

It takes 20% of the time to finish 80% of your
application -> “Prototype” (80% finished)

80% of the users only use 20% of the features

80% of performance improvements are found
by optimizing 20% of the code

80% of the bugs are found in 20% of the code

http://swreflections.blogspot.no/2013/11/applying-8020-rule-in-software.html



http://swreflections.blogspot.no/2013/11/applying-8020-rule-in-software.html

Work Items — New Bug

Now oo 17 ws s not working | We use Azure DevOps as our Bug Reporting Tool

= X
Tags Add...

WS is not working

STATUS

Assigned To

State Active
Reason New

REPRO STEPS SYSTEM INFO

Copy template URL

CLASSIFICATION PLANNING
v Area Development Project 1\Desktop - Stack Rank
~ Iteration Development Project 1\Beta ~  Priority 2
- Severity 3 - Medium
TEST CASES HISTORY ALLLINKS ATTACHMENTS

DISCUSSION ONLY ALL CHANGES
[No entries with comments]




Queries
* Used to find existing Work Items

* You may create different Queries to make it easy to find
the Work Items you need

* Queries may be personal or visible for everybody in the
project (Team Queries)

ery 1

Operator



New Query 1 . 5 work items (1 selected)
- « Creating a Query - Example
W M % 9 | ColumnOptions

Type of Query [E Flat List of Work Items & Work Items and Direct Links %3 Tree of Work Items

Filters for top level work items

And/Or Field Operator Value
b X Team Project v | = v  @Project
= X And v Work Item Type v (= ¥ [Any]
= X And v State v = v [Any]

o Add new clause

e R & » & =2 Column Options

ID Work Ite Title Assigned To State Tags
il Bug Database Error Hans-Pett... Active

2 Task Add Web functionality New

4 Test Case  Test Empty Fields Hans-Pett... Design

3 Test Case  Test Web Service Hans-Pett... Design

5 Bug WS is not working Active



-

0q] Visual Studio Online / Systemutvikiing 2015

HOME CODE  WORK  BUILD TEST
Backlogs Queries
I
<
New v u ¢
Assigned to me

Unsaved work items

4 My favorites

All Bugs

All My Work Items
4 Team favorites

All Bugs
4 My Queries

All My Work Items
4 Shared Queries

» Current Sprint

All Bugs

All Work Items

Feedback

My Bugs

New Features

You can create
Queries (both
Personal and Team
Queries)

Work Items Example

All Work Items

Results Editor Charts

i ¢ e N b & Column options  Copy query URL
1D Work Item Type Title

100 Product Backlog Item | Introduction

101 Product Backlog Item |/ ll Requirement Analysis

102 Product Backlog Item) [| Software Design

103 Product Backlog Ite Jl Development Processes

104 Task What is System Engineering

105 Task SRS .

« List of Work Items
107 Task ERwin

108 Bug Jl Database Communication fails

109 Bua l Datahase Scrint not Warkina

Product Backlog It¢m 100: Introduction

Assigned To
Olav Deehli

Hans-Petter Halvors. .

Olav Daehli

Hans-Petter Halvors...
Hans-Petter Halvors...
Hans-Petter Halvors...

Hans-Petter Halvors. .

Olav Daehli

Hans-Petter Halvors...

Olav Daehli

B ¢ 9 o =
e Work Item Details
Introduction

Hans-Petter Halvorsen | % @

Search work items

O~
[N

18 work items (1 selected)

Work item pane Bottom [,

Filter » Y
State Created By
New Hans-Petter Halvors...
New Hans-Petter Halvors...
New Hans-Petter Halvors...
New Hans-Petter Halvors...
Done Hans-Petter Halvors...
In Progress Hans-Petter Halvors...
In Progress Hans-Petter Halvors...
To Do Hans-Petter Halvors...
New Hans-Petter Halvors...
New Hans-Petter Halvors

1of 18
v

i semanins misvese s V1AKE sUCe to fill out “Assigned To”,

STATUS

Assigned To  #ijs Olav Daehli

State New ¥ Business Value
Reason New backlog item Area

DESCRIPTION STORYBOARDS TEST CASES TASKS (1)

ACCEPTANCE CRITERIA

Systemutvikling 2015

Correct “Iteration” and “Area”

HISTORY LINKS (1) ATTACHMENTS
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Unit Testing

Create Unit Tests for your code

— Not for all your code, just a few examples in order to learn
how it is done in practice.

Each member in the Team should write at least 2 Unit
Tests for their code

Planning to Create New Code? Next Time you should
try to Create a Unit Test before you start Coding

Unit Testing should also be part of the System
Documentation (coming up soon)

See Next Slides for more details...



Create Unit Tests in Visual Studio ~ "Ve=Aevy

N ame: [ One of the students submitting this form will receive a prize! ]

1 Watch/Do the Examples in the Video

] Create at least Unit Tests for 2 different Methods in
your code:
L Unit Test 1:

J Unit Test 2:

(1 Run the Units Tests:
L Failed/Passed?
(1 Code Coverage




What are Unit Tests

Unit Testing (or component testing) refers to tests
that verify the functionality of a specific section of
code, usually at the function level.

In an object-oriented environment, this is usually at
the class and methods level.

Unit Tests are typically written by the Developers as
part of the programming

Automatically executed (e.g, visual studio and -ty
Azure DevOps have built-in functionality for Unit Testing) y T



Unit Tests Frameworks

Unit Tests Framework are usually integrated with the IDE

* Visual Studio Unit Test Framework. Unit Tests are built into Visual Studio (no additional
installation needed)

Others:
* JUnit (Java)

— JUnit is a unit testing framework for the Java programming language.
* NUnit (.NET)

— NUnit is an open-source unit testing framework for Microsoft .NET. It serves the same purpose
as JUnit does in the Java world

PHPUnit (PHP)
e LabVIEW Unit Test Framework Toolkit
* etc.

All of them work in the same manner — but we will use the Visual Studio Unit Test Framework



Unit Testing and Documentation

How/where shall Unit Testing be included in the
documentation?
e Software Test Plan (STP)

— Test Planning, Unit Testing is an important part of that!

e Test Documentation

— Documentation, Test execution and Test Results, Unit Testing is an
important part of that!

e System Documentation

— Used to maintain and further development of the system, Unit
Testing is an important part of that!

— More about System Documentation Next Week!



Unit Tests — Best Practice

A Unit Test must only do one thing

Unit Test must run independently

Unit Tests must not be depend on the environment

Test Functionality rather than implementation

Test public behavior; private behavior relates to implementation details
Avoid testing Ul components

Testing Methods writing/retrieving Data to/from a Database can also be
challenging

Unit Tests must be easy to read and understand

Create rules that make sure you need to run Unit Tests (and they need to
pass) before you are allowed to Check-in your Code in the Source Code

Control System http://www.uio.no/studier/emner/matnat/ifi/INF5530



http://www.uio.no/studier/emner/matnat/ifi/INF5530

Unit Testing in Visual Studio

To create a unit test project:

1.
2.

On the File menu, choose New and then choose Project (Ctrl + Shift + N).

In the New Project dialog box, expand the Installed node, choose the
language that you want to use for your test project, and then choose Test.

To use one of the Microsoft Unit Test frameworks, choose Unit Test Project
from the list of project templates. Otherwise, choose the project template of
the Unit Test Framework that you want to use.

In your Unit Test Project, add a reference to the code under test. Here’s how
to create the reference to a code project in the same solution:

Select the project in Solution Explorer.

On the Project menu, choose Add Reference....

In the Reference Manager dialog box, open the Solution node and choose
Projects. Check the code project name and close the dialog box.



Unit Testing in Visual Studio

P Recent
4 |nstalled

4 Visual C&
Windows Store
Windows

> Web
Cloud
Reporting
Test
Workflow
TypeScript

© Other Languages
© Other Project Types

P Online

Name: UnitTestProjectl

Location:

.NET Framework 4.5

I ﬁcj Unit Test Project

Add New Project

~ | Sort by: | Default

== Search Installed Templates (Ctrl+E)

Visual C# Type: Visual C&

A project that contains unit tests.

You need to Add a “Unit Test Project” to
your existing solution in Visual Studio

Click here to go cnline and find templates.

[ C:\Work\Development\TFS\Development\Unit Tests\Bank

7 [ roweer |

| ok || cancel




Unit Testing in Visual Studio Example

ta] Solution 'Bank’ (2 projects) Add Reference to the Code under Test
- Bank | Your ordinary Project o e

D ﬁ Propertles Add Service Reference...
P =-B References Manage NuGet Packages...
P c#* BankAccount.cs Scope to This

R:‘erence Manager - BankTest ? “
4 [ BankTest — —
D ﬁ p ro p e rti e S 5::°j ::s C:\Work\Development\TFS\Development\U ';::': ;
P =B References Jep—

P c#* UnitTestl.cs

Your Unit Test Project

w
=
0
il v

ok |[ cancel




NEVER JUST
REMOVE A
FAILING TEST!

\J

geek & poke

ONLY REMOVE THE
ASSERT
\ STATEMENTS?
g Al

HOW TO SUSTAIN A DECENT
COVERAGE
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Scrum Activities and Meetings

Status: We are finished with "Beta" Iteration and
should start on the next Iteration ("RC").

Self-activities within the Teams:

1. Sprint
2. Sprint
3. Sprint

Review Meeting ("Beta" Iteration)
Retrospective ("Beta" Iteration)

Planning ("RC" Iteration)

See Next Slides for more details...



Scrum Activities and Meetings

Team:

The Team has done the following activities:

d Sprint Review Meeting ("Beta" Iteration)
Short Status report:

d Sprint Retrospective ("Beta" Iteration)

d Action List:
1. Keep doing:
2. Start doing:
3. Stop doing:

d Sprint Planning ("RC" Iteration)
d  New Sprint Backlog has been made. # Tasks: ___ Est. Hours:




[}
X
[}
Q
o3
£ 4
[}
7}
o

assert (true)

just failed!

http://geek-and-poke.com

NEVER TAKE ANYTHING FOR GRANTED ANYMORE


http://geek-and-poke.com/
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